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Introduction to What's New 

This edition of the "What's New" describes many notable new features and enhancements in 

version 10.96.2 since the previous release (10.96.1). For information on features and 

enhancements made in earlier versions, see the appropriate "What's New" document for 

those versions. 

 

For information on fixes made in version 10.96.2, see the appropriate "Resolved Issues" 

document.  

 

Note that if updates need to be made, the most up to date "What's New" and "Resolved 

Issues" documents can be found in our online documentation here:  

 

Release Notes 

Structure of the Document 

This document is split into chapters for the different areas of the ICONICS Suite, then 

further into sections for major updates, representing significant enhancements or new 

functionality, followed by tables of additional enhancements and fixes. 

Where appropriate, references to additional information, such as instructional 

application notes or help files, will be indicated. 

"First Available In" Column 

Some of these fixes were first made available in Critical Fixes Rollup Packs for 10.96.1. 

The "First Available In" column notes which rollup a fix first appeared in so that users 

who already have a rollup can determine what items are new for them.

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Intro/Release_Notes.htm
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Most Notable Features 

Some of the most notable new features in 10.96.2 are listed below. Visit each link to 

learn more and see the "Major Enhancements" sections for each product for additional 

notable features. 

• New highly customizable entry-level package: GENESIS64 Basic SCADA 

• Dark theme (i.e. "dark mode") for GraphWorX64 and Workbench 

• Begin designing GraphWorX64 displays with starter displays instead of a blank 

canvas 

• Energy AnalytiX is back in 10.96.2 with an all new engine based on Hyper 

Historian and brand new out-of-the-box KPIWorX dashboards using an AnalytiX-

BI data model 

• Quality AnalytiX's SPC chart is now available in WebHMI (HTML5) and MobileHMI 

• New SendGrid notification option for AlertWorX and CFSWorX 

• Acknowledge alarms and faults via Twilio Voice and Vonage SMS 

• Use CFSWorX AnalytiX Dashboards for analysis of alarms and faults, worker 

responses, and locations on a map 

• Salesforce integration for importing worker information 

• Use Geofences to alarm when workers have entered or exited areas and display 

Geofences in KPIWorX 

• Record worker location history and replay in KPIWorX 

• New connectivity options, including: 

o Takebishi DeviceXPlorer OPC Server now available on the ICONICS Suite 

disk with integrated ICONICS licensing 

o New connector for Ethernet/IP (also available on IoTWorX edge devices) 

o New connector for Mitsubishi Electric FA devices 

• KPIWorX can now embed WebHMI (HTML5) pages and more natively integrate 

with WebHMI
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General 

General 

Major Enhancements 

New Suite Option: GENESIS64 Basic SCADA 

(Reference ID: 76604) 

GENESIS64 now comes in two "flavors", GENESIS64 Advanced and GENESIS64 Basic 

SCADA. Users can choose one of these two packages when installing GENESIS64. 

GENESIS64 Advanced is the same GENESIS64 users may be familiar with from version 

10.96.1 and earlier. GENESIS64 Basic SCADA is a new entry-level package – the new 

standard for industrial automation. 

Basic SCADA provides the same unparalleled performance as GENESIS64 Advanced, but 

in a smaller, entry-level package designed to bring only the core functionality needed 

for a single server system without unnecessary extras. Features such as additional 

connectivity methods can be added on to customize the package to each site's needs. 

Basic SCADA systems can be used standalone or as part of a larger architecture along 

with GENESIS64 Advanced servers. 

Because GENESIS64 Basic SCADA is designed to work with single-server environments, 

distributed licensing is not available. A Basic SCADA system must connect to its own 

license server. (Cloud licensing is still available.) Redundant GENESIS64 servers are also 

not available. For these features, use GENESIS64 Advanced. 

GENESIS64 Basic SCADA systems can be WebHMI or MobileHMI servers, same as 

GENESIS64 Advanced. (MobileHMI server requires an add-on.) 

The core functionality of GENESIS64 Basic SCADA includes Workbench, GraphWorX64, 

AlarmWorX64 Server and Logger, basic AssetWorX Server, Hyper Historian Express, 

RecipeWorX, WebHMI Server, and ScriptWorX64. It can connect to OPC Classic, OPC UA, 

Mitsubishi Electric devices, and databases. Other features and connectivity are available 

as optional add-on packages, allowing users to customize their package to fit their site's 

specific needs. 
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Some features of AssetWorX are not included in Basic SCADA. Equipment classes (and 

the Bulk Asset Configurator) are not included, nor is time zone functionality, asset links 

(for distributed asset trees), and polling groups. Commanding and tree views are not 

available unless the AssetWorX Navigator add-on is purchased. Runtime parameters of 

asset properties are also limited. They cannot be used on the real-time tab of a property. 

Note that while Basic SCADA systems cannot include linked assets from other servers, its 

assets can be linked from a GENESIS64 Advanced system.  

See the table in the GENESIS64 Basic SCADA – Quick Start application note or help page 

for more details about what features come with GENESIS64 Basic SCADA versus 

GENESIS64 Advanced Application Server. 

AssetWorX Tag Counting 

A new tag counting method has been introduced with GENESIS64 Basic SCADA. With 

this new method, called "AssetWorX Tags", all IO tags must be configured as equipment 

properties in AssetWorX, ICONICS' centralized asset database. A configured asset 

property counts as a "tag" for the purposes of licensing. Only enabled properties with a 

real-time source type of Dynamic Tag or Expression counts as tags for licensing 

purposes. Properties configured to be static do not require license tags. 

When AssetWorX tag counting is enabled, Workbench will show a helpful warning 

message at the bottom of the screen should users accidentally configure more 

equipment properties than allowed in their license. The count of licensed equipment 

properties can be seen in Workbench under Assets > Product configuration > Other 

settings. This count is available even when not in AssetWorX tag counting mode or 

when looking at a configuration database that is not active.  

Workbench will also display the current tag counting mode (Advanced or Asset Tags) in 

the status bar. 

If the number of AssetWorX equipment properties exceeds the licensed tag count, 

AssetWorX will stop providing values for all properties, reporting "License Counted 

Equipment Properties Exceeded" for all asset tags. 

BACnet users should be aware that all object attributes that need to be read or written 

to must be mapped as AssetWorX equipment properties and will count as tags under 

the AssetWorX tag counting mode. This may mean projects that utilize BACnet require 

more tags when using GENESIS64 Basic SCADA than they would using GENESIS64 

Advanced. 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Com/BasicSCADA/GENESIS64_Basic_SCADA.htm%23GENESIS64_Basic_SCADA_Versus_Advanced
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In AssetWorX tag counting mode, Hyper Historian tags must be created from within the 

AssetWorX provider. Add the real-time tag as an equipment property, then go to the 

property's Historical Data tab, set the Source type to Hyper Historian Tag (or one of 

the other Hyper Historian types), then configure the settings as desired. 

When AssetWorX tag counting mode is enabled, the entire browse space will only be 

available when users are configuring AssetWorX. The tag browser in GraphWorX64 will 

only show AssetWorX and a few other providers that do not require equipment 

properties (such as Diagnostics). The lateral tag browser in Workbench (the one that is 

always visible and docked) will show the same limited list of providers, as will the pop-

up tag browser when using any Workbench provider that is not AssetWorX. The pop-up 

tag browser from inside AssetWorX is the only place that the entire address space will 

be visible. 

Changing Between Basic SCADA and Advanced 

GENESIS64 Basic SCADA and GENESIS64 Advanced cannot coexist on the same system, 

as they are two different configurations of the same product. However, a system can be 

converted from one to the other. 

Users have the option of installing GENESIS64 Advanced and then applying a 

GENESIS64 Basic SCADA license. Any Advanced functionality that is not available in Basic 

SCADA will be disabled. Note that in addition to applying a Basic SCADA license, users 

must also change the tag counting mode to fully convert a GENESIS64 Advanced system 

to a GENESIS64 Basic SCADA system. Follow these steps to change the tag counting 

mode: 

1. Open Platform Services Configuration from either Start > ICONICS Tools > 

Platform Services Configuration or Workbench > Tools > Platform Services 

Configuration. 

2. Go to the License tab. 

3. Change Tag Counting Mode to AssetWorX Tags. 

4. Apply the changes. 

5. Reboot the system when prompted. 

A system installed as GENESIS64 Basic SCADA can also be converted to a GENESIS64 

Advanced system by applying the appropriate license, however any features that were 

not included in the original installation may not function until the installation is modified 

and those modules are installed. The tag counting mode must also be changed – follow 

the steps above but choose Advanced for Tag Counting Mode. 
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Simulating a Basic SCADA License 

Users with a demo or SIP license can simulate a Basic SCADA license to ensure they are 

only using features compatible with Basic SCADA. See the new License Simulation 

feature. 

GenDemo with GENESIS64 Basic SCADA 

At this time, GenDemo has not been updated to work with GENESIS64 Basic SCADA. 

Many of the GenDemo examples will not work with a Basic SCADA installation. 

GENESIS64 Basic SCADA Users who wish to use GenDemo can do so using the 

http://gendemo.iconics.com/ example site. (Note, Internet Explorer is required.) 

For Further Reference 

• Application Notes:  

o GENESIS64 Basic SCADA – Quick Start 

o GridWorX Server - Using Data Manipulators via Call Method 

• Help:  GENESIS64 Basic SCADA 

Azure SQL Server Connections Now Support Azure Active Directory  

(Reference ID: 68197) 

Previously, configuration databases stored in Azure SQL Server could only be used with 

SQL authentication. Now, most configuration and logging databases can now support 

Azure SQL Server with Azure Active Directory credentials when said credentials are 

specified in the connection string. 

This support includes logging databases for AlarmWorX64 Logger and the legacy 

TrendWorX64 Logger. (Note, ICONICS still highly recommends Hyper Historian Express 

over the TrendWorX64 Logger for new projects.) 

ScheduleWorX64 and the Fault Viewer currently do not support Azure Active Directory. 

We plan to add Azure Active Directory support for these in a future version. 

We also plan to add support for Azure Active Directory integrated security in a future 

version. 

AlarmWorX64 Multimedia and Workbench Classic do not support Azure SQL Server or 

Azure Active Directory authentication. 

http://gendemo.iconics.com/
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Com/BasicSCADA/GENESIS64_Basic_SCADA.htm
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Installation 

Major Enhancements 

Consolidated DVDs (ISOs) 

(Reference ID: 80840) 

Previous versions released separate disks (or ISO files) for key ICONICS products, 

including GENESIS64, Hyper Historian, and CFSWorX. New in version 10.96.2, these disks 

have been combined into the ICONICS Suite disk.  

Users no longer have to question which disk they need to install a particular product. 

There are now only two disks containing all of ICONICS' offerings for version 10.96.2: 

ICONICS Suite and IoTWorX. Installations for Windows operating systems can be found 

on the ICONICS Suite disk and installations for edge devices (Linux) can be found on the 

IoTWorX disk. 

To install GENESIS64, Hyper Historian, or CFSWorX, run the ICONICS Suite installation 

and select the desired products when prompted. 

The ICONICS Suite disk previously contained installations labeled "AssetWorX" and 

"ICONICS Client". These installations have been removed; however, the same products 

can be installed using the ICONICS Suite installation.  

Shortcuts to install these products are planned to be added into the ICONICS Suite 

installation in future versions. In the meantime, to install these products, follow the 

instructions below. (These instructions can also be found in the ICONICS Suite readme 

file.) 

AssetWorX: 

1. Run the ICONICS Suite installation. 

2. When prompted, choose Custom Selection. 

3. When choosing custom options, use the Deselect Options button, then 

choose Server > Platform Services and Web Applications > Workbench 

Server. 

4. Finish the rest of the installation. 

ICONICS Client: 
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1. Run the ICONICS Suite installation. 

2. When prompted, choose Custom Selection. 

3. When choosing custom options, use the Deselect Options button, then 

choose Client. 

4. Finish the rest of the installation. 

5. Reboot if prompted. 

6. When the installation has completed, run FrameWorX Server Location from the 

start menu and enter your desired primary FrameWorX server. 

Takebishi DeviceXPlorer OPC Server 

(Reference ID: 79766) 

The Takebishi DeviceXPlorer OPC Server now comes on the ICONICS Suite disk and 

includes integrated licensing with ICONICS Suite products. 

Takebishi DeviceXPlorer OPC Server is a leading OPC server software suite that provides 

connectivity with control devices in manufacturing, factory, and operations 

environments with equipment such as PLCs, machine tools, and robots. It provides 

communication functions with multiple devices via a variety of network technology and 

helps to bridge data to various applications. Takebishi DeviceXPlorer OPC Server 

supports OPC UA, DA, AE, and SuiteLink Interface, and can connect to over 200 device 

types. 

To install DeviceXPlorer, launch the RunMe.bat file from the ICONICS Suite disk or ISO, 

then go to Additional Tools and choose one of the DeviceXPlorer OPC Server 6 

options. Alternatively, explore the disk or ISO, go to OPC_Servers > dxpserver_v611 

run setup.exe, then choose either DeviceXPlorer OPC Server 6 or DeviceXPlorer OPC 

Server 6 (x64 Edition). Follow the installation wizard, making sure to choose your 

desired PLC drivers. 

Once installed, run the DeviceXPlorer configurator by launching DeviceXPlorer OPC 

Server 6 from the start menu. For more information on how to configure the 

DeviceXPlorer OPC Server, see the Takebishi documentation at: 

https://www.faweb.net/en/product/opc  

The DeviceXPlorer is licensed via the same License Utility as the rest of the ICONICS 

Suite. Talk to your local ICONICS sales representative or distributor for more information 

on how to purchase a license for the Takebishi DeviceXPlorer. 

https://www.faweb.net/en/product/opc
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Additional Enhancements 

Ref ID Description First Available In 

77934 
The name of the IcoSetup database can now be customized when doing a silent installation. 

Use the SetupCatalogName entry in CustomSetup.ini to change this database name. 
New for 10.96.2 
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AnalytiX 

AnalytiX-BI 

AnalytiX-BI General 

Ref ID Description First Available In 

76323 

Datetime columns expose a ".DayOfWeek" subcolumn. This new subcolumn will provide the 

localized name of the day of the week. Using this column in the ORDER BY clause will sort using 

the numeric value of the day, not alphabetically.  

 

Note, in version 10.96.2, the day that starts the week is configured in the AnalyitX-BI point 

manager. To change this, go to the AnalytiX-BI server machine, open Platform Services 

Configuration, go to the Point Managers tab, select "BI Server Point Manager", then change the 

FirstDayOfWeek parameter. 

 

This DayOfWeek subcolumn can be used by KPIWorX - see 78281. 

New for 10.96.2 

80761 

When data is being loaded in a table, if the data type of the incoming data does not 

correspond to the data type of the column(s) where it is being inserted, one or more trace 

messages will be logged in TraceWorX. Previously, a warning-level message was traced for each 

row that had an issue. Now, only one message for the first invalid value will be logged at 

warning level. The other invalid values will also be logged, but at debug level instead of 

warning. 

New for 10.96.2 

AnalytiX-BI Workbench Provider 

Ref ID Description First Available In 

68871 Added a new Energy dimension for data flows to import Energy AnalytiX data. New for 10.96.2 

BridgeWorX64 & Workflow 

Ref ID Description First Available In 

77022 
The Generate Report block now contains a configuration section for Input Parameters, where 

users can specify dynamic values for the report's parameters. 
New for 10.96.2 

CFSWorX 

Major Enhancements 

Worker Access 

Geofence Alarms 

(Reference ID: 77075) 

Geofence alarms are stateful alarms that can be active while a worker is inside the 

perimeter of a geographical fence (“geofence”) area, which is defined by a contiguous 

set of GPS coordinates forming a single polygon. This shape can take many different 

forms, defined by the user to represent the perimeter of any area, for example: a site, 

campus, city, state, country, or any custom area. 
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A geofence exit alarm can also be activated while a worker is outside of a geofence. 

To use the geofence alarming feature, first you need to configure your geofences in 

Workbench. See Configuration of Geofence Locations. 

Geofence alarms require that worker MobileHMI devices be configured to send mobile 

health info, including position.  See Setting Up Mobile Device Health for more 

information. 

Once geofences are configured and mobile devices are successfully transmitting GPS 

updates, users can subscribe an alarm client (viewer, logger) to the Worker Access root 

(wa:). You will see alarms when workers enter or exit a geofence. 

For Further Reference 

• Help:   

o Geofencing Alarms 

o Geofence Configuration in MobileHMI 

 

Worker Location Path Replay 

(Reference IDs: 78136, 78135, 78348, 78335) 

Worker positioning can now be recorded, and the location data can be viewed in 

KPIWorX maps as paths. 

Warning: This feature must be used in strict accordance with all applicable laws. See the 

ICONICS licensing agreement for further details. 

Worker path replay requires that worker MobileHMI devices be configured to send 

mobile health info, including position.  See Setting Up Mobile Device Health for more 

information. 

When configured, the Worker Access Point Manger will expose a new property called 

GPSByteArray for each worker, which represents the worker's location. This can be 

logged into Hyper Historian and later parsed by the AnalytiX-BI server for display in 

KPIWorX. 

See Geofencing Support for Map Widget. 

For Further Reference 

• Help: 

o Setting up Worker Path Replay 

o CFSWorX AnalytiX Dashboard Deployment 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Setting_Up_Mobile_Device_Health.htm
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Geofencing_Alarms.htm
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/MobileHMI/Augmented_Reality.htm%23Geofence
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Setting_Up_Mobile_Device_Health.htm
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Setting_Up_Worker_Path_Replay.htm
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/CFSWorX_AnalytiX_Dashboard_Deployment.htm
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Salesforce Support for Importing Worker Information 

(Reference ID: 72323) 

You are now able to synchronize CFSWorX with a Salesforce instance to import field 

workers and their contact information. CFSWorX is able to import additional information 

about the workers including group membership, territories, and worker experience 

(characteristics). These details allow workflow logic to make the decision to contact the 

appropriate worker for the job. Field worker schedules in Salesforce can be checked to 

find the right person who is currently working.  

For Further Reference 

• Help: Configuring Salesforce 

CFSWorX AnalytiX Dashboard 

New Analysis Dashboard for CFSWorX 

(Reference ID: 76432) 

CFSWorX now come with a set of analytical dashboards for KPIWorX that helps to 

provide insight into worker responses to alarms and faults. This powerful tool helps with 

dispatching the proper field worker and ensuring that items are being responded to in a 

timely manner. 

 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Configuring_SalesForce.htm
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The CFSWorX AnalytiX Dashboard and the related configuration files can be easily 

deployed by using a Workbench package file. (See help files for more information on 

how to deploy these files.) 

With the CFSWorX AnalytiX Dashboard, users can manage alarms and faults, analyze the 

fault response data, view the location history of workers, and dispatch workers. Some of 

the statistics available in the dashboards include: 

• Events 

o Average response time by worker 

o Average response time by source 

o Response count per worker 

o Response types per worker 

o List of responses per worker 

• Region 

o Geofence crossings per worker 

o Total minutes for completed events 

• Workers 

o Active geofence events 

o Time workers have been in fences 

o Active workers in geofences 

For Further Reference 

• Help: CFSWorX AnalytiX Dashboard Deployment  

CFS Workflows 

Send SendGrid Message Block 

CFSWorX workflow templates can now include the Send SendGrid Message alert block. 

See SendGrid Email Notifications and Acknowledgement for more details. 

Additional Enhancements 

CFS Workflows 

Ref ID Description First Available In 

71736 

The existing Worker Lookup activity has been enhanced to support a User Data field. This 

allows you select a specific field worker who should be contacted for some logic in your 

workflow. This field will need to be filled in with the Worker Access tag for a specific worker 

(example: "wa:<Local-Default>/Andrew Fuller/"). 

New for 10.96.2 

74534 

75837 

It now possible to use a CFSWorX workflow to trigger the generation of a Dynamics 365 or 

Salesforce work order. This activity requires that a connection to Dynamics 365 or Salesforce be 

established using a CFSWorX Field Worker source. 

New for 10.96.2 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/CFSWorX_AnalytiX_Dashboard_Deployment.htm
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Ref ID Description First Available In 

75800 

77055 

The sample CFSWorX workflow templates have been augmented to include examples for 

supervisor escalation and automatic worker assignment. The Escalation Template provides an 

example where two workers will be notified, and then a manager will be notified if the alarm 

has not been acknowledged. The Assign Template automatically sends an email to a worker 

who has been assigned to an alarm or fault by the dispatcher. Both templates can be 

customized to meet your specific needs. 

New for 10.96.2 

76550 

76552 

CFSWorX workflows now have the ability to keep track of the current running state of a 

workflow in case the machine or service stops running unexpectedly (such as a crash or power 

loss). Alarms that have been previously processed will be squelched to avoid triggering the 

same workflow again. Note, however, that persistence is cleared if the server is stopped cleanly. 

New for 10.96.2 

77053 
The Generate Report activity has been added to CFSWorX Workflows. Previously this activity 

was only available in BridgeWorX64. 
New for 10.96.2 

77741 
The existing Send Email activity has been enhanced to support a fixed CC and BCC field. This 

can be used to send the email to additional recipient(s). 
New for 10.96.2 

77839 

The existing CFSWorX Condition activity has been enhanced to support a counter variable 

called "cfscoreVariable:CondLoopCount". When configuring the condition, go to the Alarm 

Values tab and choose CfsWorkflow Values. This can be used in the condition to quit a loop 

after the counter exceeds a certain value, for example:  

 

{{cfscoreVariable:CondLoopCount}}>3 

  

Typically, you would include a Delay block in that loop, and have the condition check for a 

change such as the alarm being acknowledged, and also check the CondLoopCount. The loop 

can be exited via the condition either if the alarm becomes acknowledged or the loop has 

executed a specified number of times. 

New for 10.96.2 

78055 

It now possible to use a CFSWorX workflow to trigger a SendGrid email to be sent. This activity 

requires that a connection to SendGrid be established using an AlertWorX SendGrid 

configuration. 

New for 10.96.2 

Energy AnalytiX 

Major Enhancements 

New Energy AnalytiX Based on Hyper Historian 

(Reference IDs: 67774, 67775) 

Energy AnalytiX returns to the ICONICS Suite in version 10.96.2. This new and improved 

version utilizes the power of Hyper Historian to bring you even more efficient energy 

calculations to help you reduce and monitor your energy usage. 

Energy assets and meters are configured in AssetWorX using an interface that will be 

familiar to legacy Energy AnalytiX users, then Hyper Historian calculates the appropriate 

energy data using a new Energy Analysis function library. The configured energy 

calculations will appear as special equipment properties under the energy assets and 

meters. These properties are automatically connected to Hyper Historian using 

AssetWorX-Hyper Historian integration, so all energy data is available through both 

AssetWorX and Hyper Historian tags. 
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Along with the new Hyper Historian calculation engine, Energy AnalytiX now comes with 

a series of premade KPIWorX dashboards to help visualize your energy consumption out 

of the box. These customizable dashboards leverage the power of AnalytiX-BI data 

models to provide a completely customizable yet immediately useful visualization 

experience. Energy data can be aggregated by time or asset and users can leverage drill-

down functionality to narrow in on a specific abnormality or interesting segment. 

 

A Hyper Historian Standard or Enterprise license is not required for Energy AnalytiX 

functionality. Energy AnalytiX can work with any edition of Hyper Historian, including 

Hyper Historian Express. (The standalone Energy AnalytiX installation comes with a 

Hyper Historian Express instance.) 

Energy AnalytiX also comes with predefined ReportWorX64 templates to create 

standard Energy Start reports. See the help files for information on how to access these 

Energy Star templates. 

The Energy AnalytiX base package includes GENESIS64 Advanced Application Server. It 

can also be purchased as an add-on for an existing GENESIS64 Advanced Application 

Server. Energy AnalytiX cannot be added to a GENESIS64 Basic SCADA system. Basic 

SCADA users must upgrade to GENESIS64 Advanced Application Server before adding 

Energy AnalytiX. 

For Further Reference 

• Application Notes: 

o Energy AnalytiX – Quick Start 

o Energy AnalytiX – Sample Energy Dashboards 
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o Energy AnalytiX – Energy Source Segmentation 

o Energy AnalytiX – Energy Source Allocation 

o Energy AnalytiX – Unit Conversions 

• Help: 

o How Energy AnalytiX Works 

o Energy Star 

Facility AnalytiX & FDDWorX 

Fault Viewer 

Ref ID Description First Available In 

75784 

Added a "Last Sample Stretch" option to the configuration of microcharts. When enabled, the 

microchart line will connect to the edge of the viewer, otherwise the line will end at the last 

sample. 

New for 10.96.2 

75785 

Added vertical axis properties to the configuration of microcharts. These properties allow the 

configuration of specific ranges and auto-scaled ranges in addition to the default range 

(obtained from the source data). 

New for 10.96.2 

75787 

Added additional appearance properties to the configuration of microcharts. For series lines, 

the fill, stroke, stroke thickness and opacity can now be set. For sample markers, the visibility, 

type (shape), stroke, fill and size can now be set. 

New for 10.96.2 

75788 
Event bar microcharts can now use @@timestamp (datetime) as a context variable for the brush 

rules. 
New for 10.96.2 

77942 

If a fault incident is selected, the default option for the comment dialog is now "Selected" 

instead of "All". If no fault incidents are selected when the dialog is opened the default remains 

"All". 

New for 10.96.2 

78364 The Rows page now contains a Tooltips section, allowing the configuration of dynamic tooltips. New for 10.96.2 

79708 

On the Columns page, the "Automatic Width" property has been replaced with the "Width 

Automation" property, which can be set to None (old Automatic Width unchecked), Auto (old 

Automatic Width checked), or Fill (new). The new Fill option will set this column to take up all 

remaining available space. 

New for 10.96.2 

ReportWorX64 & ReportWorX64 Express 

ReportWorX64 Excel Add-In 

Ref ID Description First Available In 

77757 

Expressions used in "Select from a fixed list of values" parameters are now more permissive in 

term of data types. If the expression results in a data type that does not match the parameter it 

will be automatically converted to the parameter's data type, when possible. If the expression 

result cannot be converted, a more helpful error message will aid the user in resolving the issue. 

New for 10.96.2 

78840 

Previously, when adding historical data tags to a ReportWorX64 Excel sheet the number of tags 

in the data source determined the schema of the returned columns. A single tag resulted in 

columns of Value, PointName, Quality, Timestamp, Name, DisplayName, Description, 

LowRange, HighRange, and EngineeringUnits, whereas multiple tags resulted in columns of 

ValueTag1, ValueTag2, ... ValueTagN, Timestamp. 

 

This is still true; however, users can now optionally use the extended set of columns with more 

than one tag. To change the schema of a multi-tag historical data source, edit the data source 

then enable "Always keep extended headers" on the Configuration tab. The schema of a 

historical data source with the "Always keep extended headers" option will be Pointname, 

Value, Quality, Timestamp, Name, DisplayName, Description, LowRange, HighRange, and 

EngineeringUnits. 

New for 10.96.2 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/EA/How_Energy_AnalytiX_Works.htm
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/EA/Energy_Star_Overview.htm
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Ref ID Description First Available In 

80127 

Added a new option to the properties of a historical data source called, "Show recent data on 

top". When enabled, the data will be sorted by timestamp in descending order. (When not 

enabled, the data will be sorted by timestamp in ascending order.) Note that the timestamp 

column must be present for this option to have an effect. 

New for 10.96.2 

ReportWorX64 Viewer 

Ref ID Description First Available In 

79528 

After executing a report, if the report is configured to be unavailable in Excel format, another 

available format will be downloaded. (Previously, the Excel format would be downloaded, 

regardless.) 

New for 10.96.2 

 

Quality AnalytiX 

Major Enhancements 

SPC Chart (GridWorX Viewer) 

HTML5 Support for Statistical Process Control (SPC) Chart 

(Reference ID: 44623) 

The GridWorX Viewer's SPC chart can now be used in HTML5 displays, including 

WebHMI and MobileHMI. Histogram and Line charts are supported. 

Configuration of an SPC chart is unchanged. Users can add a GridWorX Viewer to a 

GraphWorX64 display, edit the GridWorX Viewer, delete the preexisting gird object (if 

desired), then use the Add SPC Chart Wizard to add an SPC chart to the tab. 

The implementation of SPC charts is a little different between the desktop (WPF) and 

HTML5 platforms. The HTML5 SPC chart currently does not support chart zoom mode or 

chart titles. The vertical scale may not look exactly the same between the WPF and 

HTML5 version of the same display. 

For best performance, the HTML5 SPC chart should display no more than 200-300 

samples. Exact performance may vary based on your system and how many clients are in 

use at a time. Some systems may need smaller sample limits. Please reduce the samples 

in the display if you run into performance issues. 

For Further Reference 

• Help: HTML5 Support for SPC Control 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/QAX/HTML5_Support_for_SPC_Chart.htm
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Data Connectivity 

BACnet Connector 

Ref ID Description First Available In 

78275 

Certain actions previously only available to online devices are now allowed for offline devices as 

well. This allows the user to attempt to bring the device back online if it is reporting offline but 

still responsive. These actions are: AddToAlarmCache, RemoveFromAlarmCache, BackupDevice, 

RestoreDevice, DeviceCommunicationControl, ReinitializeDevice, and TimeSynchronization. 

New for 10.96.2 

EtherNet/IP Connector 

New Connector for EtherNet/IP 

(Reference ID: 73947) 

ICONICS can now natively discover and connect to Class 3 devices that support the 

EtherNet/IP network protocol defined by ODVA. 

EtherNet/IP networks and devices can be configured in Workbench under Data 

Connectivity > EtherNet/IP. It is available for both standard and IoTWorX projects. 

Devices can be automatically discovered on the local network or added manually. 

EtherNet/IP point manager tags will start with the enip prefix. 

The initial release of the EtherNet/IP point manager supports MicroLogix devices (via the 

PCCC protocol) and other Class 3 devices. Support for Class 1 devices are planned for 

future releases. 

Like many ICONICS point managers, the EtherNet/IP Point Manager provides 

performance counters for troubleshooting purposes. These can be found in the 

ICONICS Ethernet IP Point Manager category of the Windows Performance Monitor 

and in the Data Browser under Diagnostics > Control and Diagnostics > System 

Performance Counters > ICONICS Ethernet IP Point Manager or Diagnostics > 

Health Monitor > Counters > IcoModuleEthernetIPCounterName. 

For Further Reference 

• Help: EtherNet/IP Manager 

https://www.odva.org/technology-standards/key-technologies/ethernet-ip/
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/EtherNet_IP/About_EtherNet_IP_Manager.htm
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GridWorX 

GridWorX Server 

Ref ID Description First Available In 

79561 

Inline parameters now appear in the @@Execute points for data manipulators by default. These 

parameters are optional and can be ignored or removed if parameter tags are used instead. If 

desired, the appearance of inline parameters can be disabled again in Platform Services 

Configuration > Point Managers tab. Select the GridWorX Point Manager and set 

EnableInlineDataManipulatorParameters to False. (Note, even when this value is false the 

parameters can be used inline. This setting only affects whether they appear when the point is 

browsed.) 

New for 10.96.2 

Mitsubishi Electric Factory Automation (FA) Connector 

New Connector for Mitsubishi Electric FA Devices 

In 2019, ICONICS was acquired by Mitsubishi Electric Corporation and became a 

Mitsubishi Electric Group Company. In the spirit of being better together, ICONICS 

introduces the new Mitsubishi Electric FA Connector, allowing for a deeper level of 

integration between ICONICS software and Mitsubishi Electric hardware. 

The Mitsubishi Electric FA Connector can be used to connect to Mitsubishi Electric FA 

devices. It supports MELSEC iQ-R/iQ-F series PLCs and can auto-discover devices on the 

network. 

The Mitsubishi Electric FA Connector can be configured in Workbench under Data 

Connectivity > Mitsubishi Electric. 

For Further Reference 

• Help: Mitsubishi Electric FA Connector 

 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/MELCO/About_Mitsubishi_Electric_FA_Connector.htm


GENESIS64 - AlarmWorX64 

23 

GENESIS64 

AlarmWorX64 

AlarmWorX64 Logger 

Ref ID Description First Available In 

79038 

When CFSWorX is installed, the sample AlarmWorX64 Logger configuration is customized for 

CFSWorX projects (including the logging of geofence alarms). This applies both to the initial 

database created by installation and when creating new configurations in Workbench and 

choosing to include sample data. 

New for 10.96.2 

AlarmWorX64 Viewer 

Ref ID Description First Available In 

61857 The ServerNode can now be displayed in the historical alarm viewer. New for 10.96.2 

79664 

Previously, setting a time zone on one event point in an AlarmWorX64 Viewer subscription 

would apply the same time zone to all event points. Now each event point may have a unique 

time zone. Note that applying multiple different time zones to the same alarm (such as if two 

event points with different time zones return the same alarm) is not supported and will have 

unpredictable results. 

New for 10.96.2 

78923 

When a filter is used for both historical and realtime alarms, the "area" field is ignored for 

historical alarms. "Area" is not supported for historical alarms, so this allows the filter to be used 

by both realtime and historical at the same time. Filters configured this way should use the 

"Field" property and the appropriate attribute (Attribute 4 in the default logger configuration) 

to filter by area. 

10.96.1 Critical Fix 

Rollup 1 

AlertWorX 

Major Enhancements 

SendGrid Email Notifications and Acknowledgement 

(Reference IDs: 76616, 76617, 77431, 77432) 

Users can now send alerts via email using the SendGrid service. If the alert represents an 

alarm or fault, the user can acknowledge it as well. 

Similar to other services, these alerts require a SendGrid account. Go 

to https://signup.sendgrid.com/ and sign up for a SendGrid account. You can choose 

different packages based on your requirements. 

SendGrid credentials are configured under Alarms and Notifications > AlertWorX > 

SendGrid Configurations.  

For Further Reference 

• Help: Setting Up SendGrid 

https://signup.sendgrid.com/
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Setting_Up_SendGrid.htm
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Twilio Voice Acknowledgement 

(Reference ID: 76618) 

In version 10.96.1 it was possible to send outgoing Twilio Voice calls. In version 10.96.2 it 

now possible to also acknowledge alarms or faults during this call.  

Once the default Twilio Configuration with callback Url is set and you have the ICONICS 

WebAPI Service (IcoWebAPIService) running, you can initiate calls from CFSWorX on an 

alarm or fault with acknowledge options. 

The call will ask you if you want to acknowledge the call, unsubscribe, or end call. You 

can trigger acknowledgement from the call with the ACK code that is set in the 

CFSWorX provider in Workbench. It is important that the AckCode that is set in 

CFSWorX for a worker is numeric for voice calls, since we provide only DTMF input. 

For Further Reference 

• Help: Setting Up Twilio

Vonage SMS Acknowledgement 

(Reference ID: 77255) 

In version 10.96.1 it was possible to send outgoing Vonage SMS messages. In version 

10.96.2 it now possible to also acknowledge alarms or faults via Vonage SMS messages. 

For Further Reference 

• Help:

o Setting Up Vonage

o Setting Up Vonage Plugin in WebAPI

Support for Single ICONICS User Account for Services 

(Reference IDs: 79253, 79087) 

You can now use the environment variables Ico_Cfs_Username and Ico_Cfs_Password 

to set the ICONICS security account for Twilio, Vonage, and SendGrid in one place.  

Previously, you needed to set separate environment variables for each communication 

type. This also ensures that only one write client license is used by AlertWorX. See the 

help links below for full details on setting up communications. 

For Further Reference 

• Help:

o Setting up Twilio

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AlertWorX/Setting_Up_Twilio.htm
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AlertWorX/Setting_Up_Vonage.htm
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AlertWorX/Setting_Up_Vonage_Plugin_in_WebAPI.htm
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AlertWorX/Setting_Up_Twilio.htm
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o Setting up Vonage 

o Setting up SendGrid 

AssetWorX 

AssetWorX Navigator 

Ref ID Description First Available In 

75784 

Added a "Last Sample Stretch" option to the configuration of microcharts. When enabled, the 

microchart line will connect to the edge of the viewer, otherwise the line will end at the last 

sample. 

New for 10.96.2 

75785 

Added vertical axis properties to the configuration of microcharts. These properties allow the 

configuration of specific ranges and auto-scaled ranges in addition to the default range 

(obtained from the source data). 

New for 10.96.2 

75787 

Added additional appearance properties to the configuration of microcharts. For series lines, 

the fill, stroke, stroke thickness and opacity can now be set. For sample markers, the visibility, 

type (shape), stroke, fill and size can now be set. 

New for 10.96.2 

75788 
Event bar microcharts can now use @@timestamp (datetime) as a context variable for the brush 

rules. 
New for 10.96.2 

Controls 

Data Diagram 

Ref ID Description First Available In 

77168 

Added a new "Labels Angle" property to the data diagram's vertical axis (Rows page). This 

controls the angle of the vertical axis labels. This property can be used in both GraphWorX64 

pages (WPF/HTML5) and KPIWorX dashboards. 

New for 10.96.2 

Table Control 

Ref ID Description First Available In 

75784 

Added a "Last Sample Stretch" option to the configuration of microcharts. When enabled, the 

microchart line will connect to the edge of the viewer, otherwise the line will end at the last 

sample. 

New for 10.96.2 

75785 

Added vertical axis properties to the configuration of microcharts. These properties allow the 

configuration of specific ranges and auto-scaled ranges in addition to the default range 

(obtained from the source data). 

New for 10.96.2 

75787 

Added additional appearance properties to the configuration of microcharts. For series lines, 

the fill, stroke, stroke thickness and opacity can now be set. For sample markers, the visibility, 

type (shape), stroke, fill and size can now be set. 

New for 10.96.2 

75788 
Event bar microcharts can now use @@timestamp (datetime) as a context variable for the brush 

rules. 
New for 10.96.2 

78364 The Rows page now contains a Tooltips section, allowing the configuration of dynamic tooltips. New for 10.96.2 

79708 

On the Columns page, the "Automatic Width" property has been replaced with the "Width 

Automation" property, which can be set to None (old Automatic Width unchecked), Auto (old 

Automatic Width checked), or Fill (new). The new Fill option will set this column to take up all 

remaining available space. 

New for 10.96.2 

78363 

Added new properties for columns: Text Wrapping, Header Text Wrapping, Text Trimming, 

Header Text Trimming. "Wrapping" defines when text that doesn't fit into a cell will continue on 

the next line. "Trimming" defines how text overflowing a cell would be truncated or finished 

with an ellipsis (...). They apply to text in the cells or the header. 

  

These properties can have these values: 

  

Wrapping 

10.96.1 Critical Fix 

Rollup 1 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AlertWorX/Setting_Up_Vonage.htm
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Setting_Up_SendGrid.htm
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Ref ID Description First Available In 

* None - No wrapping. 

* Wrap - Text will wrap to the next line. 

* Wrap with Overflow - Text will wrap to the next line at a natural breakpoint in the text. If a 

natural breakpoint cannot be found, text will overflow. 

  

Trimming 

* None - Overflowing text is simply truncated. 

* Character Ellipsis - Overflowing text will end with an ellipsis, which is placed behind the last 

letter. This may result in incomplete words. 

* Word Ellipsis - Overflowing text will end with an ellipsis, which is placed behind whole words. 

GraphWorX64  

Major Enhancements 

Dark Theme 

(Reference ID: 78384) 

GraphWorX64 and Workbench now offer a dark mode using new application themes. 
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In GraphWorX64, the theme can be chosen from View > Application Theme. The user 

can choose from light theme (same as the default theme in previous versions) and the 

new dark theme. This preference is stored per Windows user, so different developers 

can use their preferred style. 

Note that the application theme is different from the global color themes. Global color 

themes (set in GraphWorX64 under Home > Theme) apply to the global color aliases 

used in a GraphWorX64 display. The application theme applies to the user interface of 

GraphWorX64 itself, including elements like the ribbon, explorer window, properties 

panel, and status bar. The application theme and global color themes are completely 

independent. Changing one will not affect the other. 

Systems installed as a GENESIS64 Advanced system will default to light theme (same 

look as previous versions) and those installed as GENESIS64 Basic SCADA will default to 

dark mode, however both systems can be changed to use either theme at any time. 

For Further Reference 

• Help: Dark Mode 

Starter Displays 

(Reference ID: 78394) 

Instead of starting with a blank canvas, users can now begin designing from a number 

of starter displays. These displays have been designed to have a uniform look-and-feel 

and can make it easier for new users to get up and running. 

The built-in starter displays include a powerful smart dashboard frame and several 

content displays that load within the frame. This display architecture provides a single 

place for shared content like important KPIs and navigation, making it easy to modify 

these elements without having to apply changes across multiple files. It has always been 

possible to design displays in this way, but the new starter displays make it even easier 

to understand and use this powerful design philosophy from the start. 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Com/BasicSCADA/GENESIS64_Basic_SCADA.htm%23Dark_Modebc-1
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Users can also add their own starter displays, allowing systems integrators to create a 

uniform model for all of their projects and give their engineers a consistent starting 

point. 

To create a new display using a starter display, open GraphWorX64, go to the Design 

ribbon, and select one of the displays in the Templates gallery. 

For Further Reference 

• Application Note: GraphWorX64 - Starter Displays 

• Help: Starter Displays 

Hiding Unlicensed Features and Controls 

(Reference ID: 78385) 

To help display developers focus on the features that are available to them, a number of 

features are now hidden from the GraphWorX64 ribbons when those features are not 

available in the current license.  

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/GWX10001015_Templates.htm
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Additional Enhancements 

Ref ID Description First Available In 

48756 

The asterisk indicating unsaved changes has now been moved to the beginning of the title. This 

makes it easier to see which windows have unsaved changes when previewing from the 

Windows taskbar where the name is sometimes abbreviated. 

New for 10.96.2 

66348 

The InitialValue property of process points and timedate dynamics can now accept dynamic 

values. Previously only static initial values were allowed. 

 

This new feature can be especially helpful when specifying default dataentry values for timedate 

dynamics that are relative to the current time. For example, use {{x=now()}} to set it to the 

current date and time or {{x=bday(today()+fromdays(1))}} for tomorrow (start of the day). 

New for 10.96.2 

66880 
The Kerning property is now available to objects that contain text. This new property is visible in 

Advanced mode. 
New for 10.96.2 

78612 
In configure mode, the file name is now always shown. Previously the file name would be 

hidden if there was a Title defined. Now, both the Title and file name are shown. 
New for 10.96.2 

79436 
The ReleaseDataWhenHidden property on panels is now accessible via the localsim:property: 

panelName.ReleaseDataWhenHidden variable. 
New for 10.96.2 

RecipeWorX 

Recipe Navigator 

Ref ID Description First Available In 

79856 

The Initial Selection field in the Recipe Navigator now supports global aliases. Users should 

remember that this is to set the initial selection in the navigator, meaning changing this alias in 

runtime after the navigator has loaded is not expected to change the selection. 

 

The Initial Selection field also now supports browsing. Note that only recipe tags and global 

aliases are supported. Choosing non-recipe tags will result in nothing being initially selected. 

New for 10.96.2 
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Hyper Historian 

Hyper Historian Workbench Provider 

Ref ID Description First Available In 

78733 
When the sample Hyper Historian database is in use, new tags now use the 1 second collector 

group as the default group. Previously the 50 ms collector group was the default. 
New for 10.96.2 



IoTWorX & Internet of Things - IoT Data Sources 

31 

IoTWorX & Internet of Things 

IoT Data Sources 

Major Enhancements 

New EtherNet/IP Connector 

(Reference ID: 73947) 

The new Ethernet/IP Connector is also available for Edge devices. See New Connector 

for EtherNet/IP for more details on this new connector. 

Internet of Things Workbench Provider 

BACnet 

Ref ID Description First Available In 

78742 When creating a new network entity, the network number is now set to 0 by default. 
10.96.1 Critical Fix 

Rollup 1 

78776 

The object discovery dialog no longer launches automatically after defining the device. (This 

behavior was not useful in an IoT project because the device has to be deployed before object 

discovery can occur.) 

10.96.1 Critical Fix 

Rollup 1 
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KPIWorX 

Major Enhancements 

General 

Collapsible Navigation Bar 

(Reference ID: 77534) 

The KPIWorX navigation bar can now be collapsed into 

icons. When collapsed like this, the bar can be accessed 

in both edit and presentation mode. Users can select an 

icon to load the appropriate saved dashboard. The 

dashboard names are available as tooltips, or the user 

can expand the navigation bar to see the names. 

To collapse the navigation bar: 

1. Select the KPIWorX name in the header to open the 

navigation bar. 

2. Select the pin  icon to pin the bar. 

3. Select the KPIWorX name in the header again. 

The navigation bar also now more clearly highlights which dashboard is currently open. 

For Further Reference 

• Help: Collapsible Navigation Bar 

Incorporate WebHMI and Other Pages into Dashboards 

(Reference ID: 77376, 78689) 

Users can now add any URL to the navigation bar, not just KPIWorX dashboards. The 

most common use is to add WebHMI (HTML5) pages for more seamless navigation 

between KPIWorX dashboards and GraphWorX64 WebHMI pages; however, any URL 

that allows embedding can be added. Users can add links to documentation or other 

useful pages, allowing KPIWorX to become your users' primary interface to every page 

they need. 

To add a page into the navigation bar: 

1. Put KPIWorX into edit mode. 

2. Expand the navigation bar. 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/KPIWorX/Collapsible_Navigation_Bar.htm
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3. Select the edit  icon. 

4. Select the add  icon. 

5. In the Create Dashboard/Display Link window, enter your URL in the Link URL 

field. 

6. Enter a name and fill in the other fields as desired. 

7. Select Ok. 

In presentation mode, selecting this display link will load the desired URL inside the 

main dashboard area of the dashboard. URLs can also be loaded in edit mode, but a 

"Link Mode (Limited Customization)" label will be displayed, indicating that the page 

cannot be edited like standard KPIWorX widgets. 

When WebHMI pages are loaded in this way, if the WebHMI page executes a Load KPI 

Dashboard pick action, the new dashboard will be loaded in the same KPIWorX 

dashboard frame, allowing seamless navigation back and forth between dashboards and 

WebHMI displays. 

Furthermore, the Load KPI Dashboard command has a new parameter called 

Parameters. The Parameters parameter can be used to specify filters for the dashboard 

being loaded, further deepening the integration between KPIWorX and WebHMI. For 

example, users can create a floor plan WebHMI display with pick actions for the different 

regions of the floor, and each pick action can load the same dashboard, filtered for that 

particular region. 

To create a Load KPI Dashboard pick action that leverages this functionality, configure it 

with these values: 

DashboardName The name of the dashboard, including visibility. (Example: 

Public\MyDashboard.) This name, including visibility and the 

proper formatting, can easily be copied by going to the 

dashboard header and selecting more  > Share > Dashboard 

Name > Clipboard. 

Parameters 

A string representing the filter to be applied. As an example, 

Northwind.Categories.CategoryName=Confections could be used to filter on the "Confections" 

category in the sample Northwind data model. 

Target Set to AssetPage to target the KPIWorX content area. 

 

For Further Reference 

• Help: Incorporating WebHMI and Other Pages Into Dashboards 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/KPIWorX/Incorporating_WebHMI_and_Other_Pages_Into_Dashboards.htm
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Filtering 

Scopes 

(Reference ID: 74323) 

Previously in KPIWorX, applying a filter (such as when choosing an item in a filter 

widget) would apply that filter across all widgets on the dashboard. Now, in version 

10.96.2, the user can define different filtering scopes, allowing the creation of filters that 

only affect certain widgets. This opens up greater dashboard possibilities, such as 

comparing two time periods or two assets in the same dataset. 

To configure widgets with different 

scopes, make sure you are in edit 

mode, then go to the new BI tab in 

KPIWorX. There you will find the Scope 

section where you can add, delete, rename, and choose the color for different scopes. 

Select a widget, then select a new scope in the BI tab to move the widget to that scope. 

You will notice that the widget has a colored outline in edit mode, providing a visual 

indicator of its scope. 

The filter menu in the header will display the filters in the different scopes. They can be 

cleared independently, if desired. 

Scopes are saved on a per-dashboard level. Each dashboard can have a different set of 

scopes. 

For Further Reference 

• Help: Scopes 

Relative Datetime Filters 

(Reference ID: 75504) 

Filters on a datetime column can now use dates and times relative to the current time. 

Select a widget that includes a datetime column, then go to the Widget Settings panel. 

Add a filter for your datetime column, set its filter type to Advanced, select the 

calendar  icon for one of the condition fields, then select Presets. You can choose 

from presets such as "Today" or "Last Week" and can apply an offset such as "2 days". 

This allows for the creation of dashboards that always load showing relevant data, 

instead of having to be hard coded for a specific date range that may quickly become 

the past. 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/KPIWorX/BI_Data_in_KPIWorX.htm%23Scopes
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The relative datetime functionality is also available on dashboard-level filters. The icon 

to access dashboard-level filters has been moved to the BI tab. Select the BI tab, then 

select the filter  icon. Add a filter for a datetime column and observe the same preset 

dates in the advanced filter settings. 

For Further Reference 

• Help: Relative Datetime Filters 

Widgets 

New Tree Widget 

(Reference ID: 68434) 

A new widget available in the Component Library is the tree widget. The tree widget can 

be connected to a column that contains a hierarchy. The two hierarchies currently 

supported are datetime columns and asset columns. 

A datetime column visualized in the tree widget will show a tree with the year as the top 

level, followed by month, day of month, hour, etc. 

The tree widget can control the drill-down of other charts. For example, a user can 

expand the year 2020 in a datetime widget, select the month of November, and other 

chart widgets on the dashboard will automatically drill down into November of 2020. 

When the tree widget is configured to be one row high it becomes a bread crumb bar. 

For Further Reference 

• Help: Tree 

Geofencing Support for Map Widget 

(Reference ID: 78352, 78842) 

The map widget supports geofencing. The map can display the geofences and worker 

paths. 

To show geofences, edit the map widget settings and enable Show geofences. 

To configure worker paths, set the Symbol of the map widget to path. Map the 

Latitude, Longitude, and TimestampPathBinding properties to appropriate columns 

of your worker dataset and map the Measure column to the name or ID of your worker 

dataset. 

See Configuration of Geofence Locations for how to create geofences. 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/KPIWorX/Enhanced_Filtering.htm%23Relative_Datetime_Filters
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/KPIWorX/Working_with_Other_Components.htm%23Tree
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For Further Reference 

• Help: Geofencing Support for Map Widget 

Additional Enhancements 

General 

Ref ID Description First Available In 

76325 

Chart vertical axes now include a Display Units property. This property can be used to shorten 

the displayed values in cases of very large numbers. Choosing "Thousands", "Millions", or 

"Billions" will shorten the value to the chosen units with an appropriate label (for instance, 

50000 with a Display Units of "Thousands" will show as 50k). Choosing "Auto" will allow the 

chart to choose the unit based on the value. Choosing "None" will not perform any shortening. 

New for 10.96.2 

76545 Enhanced the goal tracker widget to make better use of the available space. New for 10.96.2 

76884 The horizontal axis of a categorical chart now accepts a formatting string. New for 10.96.2 

78281 

Datetime columns now have a new subcolumn named "DayOfWeek". This new subcolumn can 

be added anywhere a normal column can be used and will provide the localized name of the 

day of the week. (Existing subcolumns for datetime columns included Year, Month, Day, etc.) 

The values will also be ordered by date order (not alphabetically).  

 

Note, in version 10.96.2, the day that starts the week is determined by the AnalytiX-BI server 

that is providing the data. To change this, go to the AnalytiX-BI server machine, open Platform 

Services Configuration, go to the Point Managers tab, select "BI Server Point Manager", then 

change the FirstDayOfWeek parameter. 

New for 10.96.2 

79207 

Added a new "Mode" to the calendar widget: Single. When choosing the "Single" mode, only a 

single day will be selected. The applied filter will go from the beginning of the day to the end of 

the day. 

New for 10.96.2 

Widgets 

Ref ID Description First Available In 

77168 

Added a new "Labels Angle" property to the data diagram's vertical axis (Rows page). This 

controls the angle of the vertical axis labels. This property can be used in both GraphWorX64 

pages (WPF/HTML5) and KPIWorX dashboards. 

New for 10.96.2 

 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/KPIWorX/Working_with_Other_Components.htm%23Geofencing_Support_for_Map_Widget


MobileHMI & HTML5 WebHMI - HTML5, iOS, Android Platform 

37 

MobileHMI & HTML5 WebHMI 

HTML5, iOS, Android Platform 

Major Enhancements 

Feature Parity Improvements 

HTML5 browsers and the MobileHMI apps for iOS and Android can now use the 

following features and functionality that were previously only available in the desktop 

GraphWorX64 app (WPF) or the Universal Windows Platform (WPF) MobileHMI app. 

AlarmWorX64 Viewer 
Ref ID Description First Available In 

77100 The context menu now includes an option to show or hide the grouping header. New for 10.96.2 

GraphWorX64  
Ref ID Description First Available In 

76372 The "SuppressErrorMessages" GridWorX Viewer property is now supported. New for 10.96.2 

78735 Dynamic content in the Text property of RuntimeWindowProperties. New for 10.96.2 

GridWorX Viewer  
Ref ID Description First Available In 

44623 SPC charts (Quality AnalytiX). (See HTML5 Support for Statistical Process Control (SPC) Chart.) New for 10.96.2 

77636 The ClusterPadding property of GridWorX Viewer charts. New for 10.96.2 

79084 The context menu now includes an option to show or hide the grouping header. New for 10.96.2 

77693 HTML5 GridWorX Viewer charts now respect the "VerticalGridInterval" property. 
10.96.1 Critical Fix 

Rollup 1 

77740 HTML5 GridWorX Viewer charts now respect the "EnableSmartLabels" property. 
10.96.1 Critical Fix 

Rollup 1 

Additional Enhancements 

GraphWorX64 

Ref ID Description First Available In 

66348 

The InitialValue property of process points and timedate dynamics can now accept dynamic 

values. Previously only static initial values were allowed. 

 

This new feature can be especially helpful when specifying default dataentry values for timedate 

dynamics that are relative to the current time. For example, use {{x=now()}} to set it to the 

current date and time or {{x=bday(today()+fromdays(1))}} for tomorrow (start of the day). 

New for 10.96.2 

GridWorX Viewer 

Ref ID Description First Available In 

78271 

When exporting a CSV file from the HTML5 GridWorX Viewer, the semicolon (;) is now used as 

the delimiter instead of a comma (,). This is now consistent with the desktop (WPF) GridWorX 

Viewer and avoids problems with regional settings where the comma is used as the decimal 

separator. 

10.96.1 Critical Fix 

Rollup 1 
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MobileHMI Workbench Provider 

Major Enhancements 

Configuration of Geofence Locations 

(Reference ID: 77768) 

It is now possible to create geofence polygons in the MobileHMI Augmented Reality 

configuration.  

Configure your geofences in Workbench under MobileHMI > Configuration > 

Augmented Reality.  

Geofences can be displayed in a KPIWorX map widget as described in Geofencing 

Support for Map Widget.  

Geofences can also be used to create alarms when workers cross in or out of the 

boundaries. See Geofence Alarms. 

For Further Reference 

• Help: MobileHMI Augmented Reality Geofences 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/MobileHMI/Augmented_Reality.htm%23Geofence
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Platform Services 

Commanding 

Ref ID Description First Available In 

79289 
Enhanced the tracing of commands to help identify which client is calling commands using 

invalid parameters. 
New for 10.96.2 

80242 
The Acknowledge command can now specify the shelve duration when performing a ShelveOn 

operation. Set the "Unshelve After" property with the desired number of seconds. 
New for 10.96.2 

FrameWorX Server 

Ref ID Description First Available In 

76939 

Process affinity can now be set for FrameWorX and point managers. Process affinity is a bitmask 

representing which logical processor cores a process can use (example: a process affinity of 5 

can only run on the first and third cores). A value of zero indicates the process will use the 

process's default affinity (usually all cores). 

 

To set the affinity for FrameWorX, edit FwxServer.Network.config and change the 

<ProcessAffinity> value.  

 

To set the affinity for an out-of-process point manager, edit FwxServer.PointManagers.config, 

find the appropriate PointManagerConfiguration item, and add a <ProcessAffinity> value in 

that section. (The ProcessAffinity value will be ignored if the point manager is running in-

process.) 

 

(Note that certain legacy applications such as AlarmWorX64 Server must have their affinity set 

in the IcoSetup64.ini file. Find the appropriate header and add or modify the 

ProcessAffinityMask entry. This is not new functionality and has not changed for this version.) 

New for 10.96.2 

78955 

It is now possible to specify the namespace index instead of the namespace URI in an OPC UA 

point name. The namespace index must be typed manually (it cannot be browsed).  

 

Example point with namespace URI (original syntax): 

ua:DASample\\[http://opcfoundation.org/Quickstarts/DataAccess]TestData/Static/CC1001.Input

1 

 

Example point using namespace index (new optional syntax): 

ua:DASample\\[2]TestData/Static/CC1001.Input1 

 

Note that the namespace indices are not guaranteed to remain the same. Some servers will 

change the indices every session. If this happens, the points specifying the old index will stop 

working. For this reason, it is recommended to continue to use the original namespace URI 

syntax whenever possible, and only use the namespace index syntax when the index is 

guaranteed by the server to not change. 

 

This feature was added to facilitate rare systems that have two servers with the same 

namespace URI or other unusual circumstances that make the namespace URI difficult to use. 

New for 10.96.2 

Health Monitoring 

Ref ID Description First Available In 

79580 
System Health Monitor pages were enhanced with a number of additional counters for a more 

complete picture of your system. 
New for 10.96.2 
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Licensing 

Major Enhancements 

Easier Demo or Trial Reset 

(Reference IDs: 79704) 

Previously, when the built-in 12-hour demo expires it was necessary to restart the 

ICONICS License Service or the machine to start a new 12-hour period.  

Now, Workbench will display a helpful message notifying you that your trial has expired. 

Furthermore, the user can simply select this message and the demo period will reset. It 

is no longer necessary to find and restart the appropriate service. 

This works for both the built-in 12-hour demo and the new ICO360-TRIAL-SIP licenses 

for registered system integrators.  

For Further Reference 

• Help: Licensing Options 

New ICO360-TRIAL-SIP License 

(Reference ID: 79312) 

A new license is available for Systems Integrators who join at our new Registered level. 

The ICO360-TRIAL-SIP license offers a new level of system integrator license between 

the built-in 12-hour demo and a full ICO360-SIP license (available to systems integrators 

at Enrolled level and above). 

The new ICO360-TRIAL-SIP license offers unlimited development time, but its runtime 

will time out after two hours. The runtime can be easily restarted using the new demo or 

trial reset functionality in Workbench, mentioned above. It contains more tags, 

advanced clients, and other options than the built-in demo.  

The status bar of Workbench will show the remaining runtime duration of an ICO360-

TRIAL-SIP license. 

Like ICO360-SIP licenses, the ICO360-TRIAL-SIP licenses include must be renewed every 

year. 

The new ICO360-TRIAL-SIP licenses cannot be run as a cloud license. It must be 

activated as a software or hardware license. 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Arch/LIC/Licensing_Options.htm
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The table below helps describe the differences between the demo that comes with every 

ICONICS Suite installation, the new ICO360-TRIAL-SIP license, and the ICO360-SIP 

license. 

 Built-In Demo ICO360-TRIAL-SIP 

(New) 

ICO360-SIP 

Activation Method 
None – in effect whenever 

system has no license 

Activate via Web Licensing 

Utility 

Activate via Web Licensing 

Utility 

Required SI Program Level None Registered Enrolled and above 

Development Duration 12 hours Unlimited (until expiration) Unlimited (until expiration) 

Runtime Duration 12 hours 2 hours Unlimited (until expiration) 

Duration Displayed in 

Workbench 
No Yes NA 

License Expiration None 1 year 1 year 

GENESIS64 Tags 64 50,000 100,000 

Hyper Historian Tags 64 50,000 100,000 

Advanced Clients 1 5 25 

ReportWorX64 Reports 5 25 1000 

BridgeWorX64 Transactions 5 25 1000 

Energy AnalytiX Meter Assets 24 25 100 

FDDWorX Assets 24 25 100 

Available as Cloud License NA No Yes 

 

Contact your local ICONICS sales representative or distributor for more information on 

how to obtain an ICO360-TRIAL-SIP license. 

For Further Reference 

• Help: ICO360-TRIAL-SIP License 

License Simulation 

(Reference IDs: 78730) 

Users with a demo or SIP license can now simulate having fewer elements in their 

license.  

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Arch/LIC/ICO360-Trial_License.htm
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This license simulation feature can help a systems integrator to develop for an end user 

that will be using a GENESIS64 Basic SCADA license or another license with a reduced 

feature set. The SIP license can be reduced to the features of Basic SCADA or to 

otherwise match the end user license. This can help ensure that the integrator does not 

unintentionally use features in the project that will not be usable on the end user's 

system without requiring the integrator to obtain a compatible license and apply it to 

the development system. The development system can continue using the integrator's 

SIP license, and the integrator can even switch back and forth between projects with 

different license requirements. 

To use the license simulation feature: 

1. Open the License Viewer from either Start > ICONICS .NET Licensing > 

MonitorWorX Viewer or from Workbench > Tools > Licensing.  

2. Go to the Simulator tab. 

3. Select Enable Simulator. 

4. Modify the License Count values as needed. To quickly switch to a Basic SCADA 

license, select the Basic SCADA Mode button. This will change the values below 

to simulate a GENESIS64 Basic SCADA license without any add-ons. 

Note that to fully emulate GENESIS64 Basic SCADA functionality the user also needs to 

change the tag counting mode: 

1. Open Platform Services Configuration from either Start > ICONICS Tools > 

Platform Services Configuration or Workbench > Tools > Platform Services 

Configuration. 

2. Go to the License tab. 

3. Change Tag Counting Mode to AssetWorX Tags. 

4. Apply the changes. 

5. Reboot the system when prompted. 

When license simulation is enabled, an orange bar 

warning will be shown at the bottom of the license 

viewer.  

License simulation is supported for software or hardware keys, but not cloud licenses. 

For Further Reference 

• Help: License Simulation 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Arch/LIC/License_Simulation.htm
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Partial Compatibility with 10.96 and 10.96.1 Licenses 

(Reference IDs: 80018) 

The licensing has significantly changed between version 10.96.1 and 10.96.2. Normally a 

change of this level would require users upgrading a system to also upgrade their 

licenses using the Web Licensing Utility, but version 10.96.2 was specifically enhanced to 

support using an existing 10.96 or 10.96.1 license. 

This compatibility with existing 10.96 or 10.96.1 licenses works best with systems that do 

not share a license between multiple FrameWorX servers. An easy way to determine if 

you need to upgrade your license after upgrading your software is to open Platform 

Services Configuration, go to the License tab, and view the License Location. 

If your License Location is set to Local License Key, then you should not need to 

upgrade your license in the Web Licensing Utility after upgrading your software. 

If your License Location is set to Remote License, especially if you have multiple servers 

looking at the same remote license server, then it is best to upgrade your license in the 

Web Licensing Utility after upgrading your software to ensure you have a proper license 

for everything you have purchased. 

For Further Reference 

• Help: Using the ICONICS Web Licensing Utility to Upgrade Your License 

Security 

Ref ID Description First Available In 

77919 

A new optional setting has been added for HTML5 displays that will redirect the user to a 

specific page when they log out (more specifically, when the user has changed and the new 

security context no longer has access to the current page). By default, when a user logs out the 

same page is re-requested and the “access denied” page is shown if the user does not have 

access to the page. When this setting is configured, instead the user will be redirected to the 

specified URL. 

  

To configure this setting, edit the AfterLogoutUrl value in the ico.anyglass.parsing.config file. A 

blank value will use the default behavior (no redirect after logout). 

  

This setting can be used to prevent the user from automatically logging back in if they are 

using SAML security and the SAML token still exists. 

New for 10.96.2 

https://licensing.iconics.com/
https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Arch/LIC/Using_the_ICONICS_Web_Licensing_Utility_to_Upgrade_a_License.htm
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WebAPI 

Major Enhancements 

Support for WebHooks 

(Reference ID: 75195) 

WebAPI now includes support for WebHooks.  

Users can use WebHooks to get data from third party applications. This data is made 

available as alarms in the svrsim:message alarm source. The message of the alarm is 

the JSON or XML payload of the WebHook call.  

Users can subscribe to these alarms with the AlarmWorX64 Viewer for simple display 

or use BridgeWorX64 and its JSON Content Reader activity to parse the payload and 

take action on it, such as writing it to a database, copying it to tags to be displayed in 

GraphWorX64, and more. 

WebAPI's implementation uses OAuth 2.0 and supports both JSON, XML, and plaintext 

payloads. Supported HTTP methods are GET and POST. 

For Further Reference 

• Help: Generic Webhook Support 

Unified Data Manager 

Ref ID Description First Available In 

77151 

Process affinity can now be set for the Unified Data Manager. Process affinity is a bitmask 

representing which logical processor cores a process can use (example: a process affinity of 5 

can only run on the first and third cores). 

 

The Unified Data Manager's affinity is set in the IcoSetup64.ini file. Find or modify this entry: 

 

[DATAMANAGER\Configuration] 

ProcessAffinityMask=0 

 

If the ProcessAffinityMask entry is not present (default), the process will use all available cores. 

New for 10.96.2 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/WebAPI/Generic_Webhook_Support.htm
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Workbench 

Major Enhancements 

Dark Theme 

(Reference ID: 78722) 

GraphWorX64 and Workbench now offer a dark mode using new application themes.  

 

In Workbench, the theme can be chosen from Tools > Themes. The user can choose 

from light theme (same as the default theme in previous versions) and the new dark 

theme. This preference is stored per Windows user, so different developers can use their 

preferred style. 

Systems installed as a GENESIS64 Advanced system will default to light theme (same 

look as previous versions) and those installed as GENESIS64 Basic SCADA will default to 

dark mode, however both systems can be changed to use either theme at any time. 

For Further Reference 

• Help: Dark Mode 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Com/BasicSCADA/GENESIS64_Basic_SCADA.htm%23Dark_Modebc-1
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Automatically Update Project when License Changes 

(Reference ID: 78728) 

To make sure that users are able to use applications they purchased and are not 

bothered by those they haven't, Workbench now listens for changes to the installed 

license, and if it detects an appropriate change it will guide the user through enabling or 

disabling Workbench providers and applications to match the new license. This makes 

the process of applying a new license more intuitive. The process is optional – users are 

free to not add or not remove providers. 

When Workbench detects a change (this 

may take a few seconds), it pops up a 

special notification that prompts the user 

to start the system update process. 

When the user selects the message, a 

Project Update Wizard appears and 

guides the user through the process of 

updating the project to match the license. The process can be canceled at any time. If 

canceled, no changes will be made, and the user will not be prompted for any further 

changes unless the license changes again. Changes can still be made manually in the 

"Configure Application Setting(s)" dialog. 

If the Project Update Wizard needs to 

remove an application, it will hide the 

provider in the Workbench tree and 

disable the associated services or in-

process point managers. No 

configuration databases will be 

removed, so no work will be lost if an 

application is mistakenly removed. 

(Configuration tables or databases must 

be removed manually if the user 

desires.) 

If the Project Update Wizard needs to 

add an application, it will prompt the 

user for SQL Server credentials used for 

the configuration database. The user will have the option to overwrite existing 

configuration data or keep the configuration already present. The providers will be 

added to the Workbench tree and any associated services or in-process point managers 

will be enabled. 
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Changes will be made once the user selects Update on the last page of the wizard. They 

may take a few minutes. Depending on the changes, the wizard may notify the user that 

a restart of FrameWorX is be required. 

If the user canceled a project update prompt and later decides they would like to finish 

the process they can use the Update Applications button on the Project ribbon to 

launch the Project Update Wizard. 

For Further Reference 

• Help: Automatically Update Project When License Changes 

https://docs.iconics.com/V10.96.2/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/ProjectWorX/Automatically_Update_Project_When_License_Changes.htm
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